
Digi - 20-101-0454 Datasheet

Welcome to E-XFL.COM

Understanding Embedded - Microcontroller,
Microprocessor, FPGA Modules

Embedded - Microcontroller, Microprocessor, and FPGA
Modules are fundamental components in modern
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and capabilities. Microcontrollers are compact integrated
circuits designed to execute specific control tasks within
an embedded system. They typically include a processor,
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requiring external memory and peripherals. FPGAs (Field
Programmable Gate Arrays) are highly flexible devices that
can be configured by the user to perform specific logic
functions, making them invaluable in applications requiring
customization and adaptability.

Applications of Embedded - Microcontroller,
Microprocessor, FPGA Modules

These modules are integral to numerous applications
across various industries. Microcontrollers are commonly
used in consumer electronics, automotive systems,
industrial automation, and home appliances, providing
efficient control and processing capabilities.
Microprocessors power more complex systems such as
personal computers, servers, and advanced
communication devices. FPGAs find their applications in
fields requiring high-performance computation and real-
time processing, including telecommunications, medical
devices, aerospace, and defense systems. Their versatility
allows for rapid prototyping and the implementation of
custom hardware solutions, making them ideal for
innovative and cutting-edge applications.
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Microcontroller, Microprocessor, FPGA Modules

Embedded modules can be categorized based on their
functionalities and intended applications. Microcontrollers
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and their integrated features, such as ADCs (Analog-to-
Digital Converters) and communication interfaces.
Microprocessors are categorized by their architecture (x86,
ARM, RISC-V) and performance metrics like clock speed
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integrated features like DSP (Digital Signal Processing)
blocks and high-speed transceivers. These subcategories
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Microprocessor, FPGA Modules
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to different application needs. Basic microcontrollers, such
as the 8-bit AVR series from Microchip, are ideal for simple
control tasks. More advanced 32-bit microcontrollers, like
the STM32 series from STMicroelectronics, offer higher
performance and greater peripheral integration. In the
realm of microprocessors, the ARM Cortex-A series is
popular for its balance of power efficiency and
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2.1.3  Connect Power

When all other connections have been made, you can connect power to the RCM2200 
Prototyping Board.

First, prepare the AC adapter for the country where it will be used by selecting the plug. 
The RCM2200 Development Kit presently includes Canada/Japan/U.S., Australia/N.Z., 
U.K., and European style plugs. Snap in the top of the plug assembly into the slot at the 
top of the AC adapter as shown in Figure 3, then press down on the spring-loaded clip 
below the plug assembly to allow the plug assembly to click into place.

Connect the AC adapter to 3-pin header J5 on the Prototyping Board as shown in Figure 3 
below. The connector may be attached either way as long as it is not offset to one side.

Figure 3.  Power Supply Connections

Plug in the AC adapter. The power LED on the Prototyping Board should light up. The 
RCM2200 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow hardware reset 
without disconnecting power.
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3.  RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM2200 (and for all
other Rabbit hardware), you must install and use Dynamic C.
This chapter provides a tour of the sample programs for the
RCM2200.

3.1  Sample Programs
To help familiarize you with the RCM2200 modules, several sample Dynamic C programs 
have been included. Loading, executing and studying these programs will give you a solid 
hands-on overview of the RC M2200’s capabilities, as well as a quick start with Dynamic C 
as an application development tool. These programs are intended to serve as tutorials, but 
then can also be used as starting points or building blocks for your own applications.

NOTE: It is assumed in this section that you have at least an elementary grasp of ANSI C. 
If you do not, see the introductory pages of the Dynamic C User’s Manual for a sug-
gested reading list.

Each sample program has comments that describe the purpose and function of the program.

Before running any of these sample program, make sure that your RCM2200 is connected 
to the Prototyping Board and to your PC as described in Section 2.1, “Connections.” To 
run a sample program, open it with the File menu (if it is not already open), then compile 
and run it by pressing F9 or by selecting Run in the Run menu.

Sample programs are provided in the Dynamic C SAMPLES folder. Two folders contain 
sample programs that illustrate features unique to the RCM2200.

• RCM2200—Demonstrates the basic operation and the Ethernet functionality of the 
RCM2200.

• TCPIP—Demonstrates more advanced TCP/IP programming for Rabbit’s Ethernet-
enabled Rabbit-based boards.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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tion of how Dynamic C handles multitasking with costatements and cofunctions, see 
Chapter 5, “Multitasking with Dynamic C,” and Chapter 6, “The Virtual Driver,” in the 
Dynamic C User’s Manual.

3.1.4.3  TOGGLELED.C

One of Dynamic C’s unique and powerful aspects is its ability to efficiently multitask 
using cofunctions and costatements. This simple application demonstrates how these pro-
gram elements work.

This sample program uses two costatements to set up and manage the two tasks. Costate-
ments must be contained in a loop that will “tap” each of them at regular intervals. This 
program:

1. Initializes the pins of Port A as outputs.

2. Sets all the pins of Port A high, turning off the attached LEDs.

3. Sets the toggled LED status variable vswitch to 0 (LED off).

4. Starts an endless loop using a while(1) expression, and within that loop:

• Executes a costatement that flashes LED DS3;

• Executes a costatement that checks the state of switch S2 and toggles the state of 
vswitch if it is pressed;

• Turns LED DS2 on or off, according to the state of vswitch.

These steps repeat as long as the program is allowed to run.

The first costatement is a compressed version of FLASHLED.c, with slightly different 
flash timing. It also uses the library function DelayMs() to deliver more accurate timing 
than the simple delay loops of the previous program.

The second costatement does more than check the status of S2. Switch contacts often 
“bounce” open and closed several times when the switch is actuated, and each bounce can 
be interpreted by fast digital logic as an independent press. To clean up this input, the code 
in the second costatement “debounces” the switch signal by waiting 50 milliseconds and 
checking the state of the switch again. If it is detected as being closed both times, the pro-
gram considers it a valid switch press and toggles vswitch.

Unlike most C statements, the two costatements are not executed in their entirety on each 
iteration of the while(1) loop. Instead, the list of statements within each costatement is 
initiated on the first loop, and then executed one “slice” at a time on each successive inter-
ation. This mode of operation is known as a state machine, a powerful concept that per-
mits a single processor to efficiently handle a number of independent tasks.

The ability of Dynamic C to manage state machine programs enables you to create very 
powerful and efficient embedded systems with much greater ease than other programming 
methods.

More Information
See the entries for the DelayMs() function, as well as Section 5, “Multitasking with 
Dynamic C,” in the Dynamic C User’s Manual.
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The RJ-45 connector is shielded to minimize EMI effects to/from the Ethernet signals. 
Rabbit recommends that an equivalent RJ-45 connector be used on the user board if the 
customer wishes to have an RJ-45 connector on the user board.

NOTE: The RCM2210 is available without the LEDs and the RJ-45 connector if you 
plan to use your own RJ-45 connector on your user board.

4.2.3  Programming Port

The RCM2200 has a 10-pin program header labeled J1. The programming port uses the 
Rabbit 2000’s Serial Port A for communication. Dynamic C uses the programming port to 
download and debug programs.

The programming port is also used for the following operations.

• Cold-boot the Rabbit 2000 after a reset.

• Remotely download and debug a program over an Ethernet connection using the 
RabbitLink EG2110.

• Fast copy designated portions of flash memory from one Rabbit-based board (the 
master) to another (the slave) using the Rabbit Cloning Board.

Alternate Uses of the Serial Programming Port

All three clocked Serial Port A signals are available as

• a synchronous serial port

• an asynchronous serial port, with the clock line usable as a general CMOS input

The serial programming port may also be used as a serial port via the DIAG connector on 
the serial programming cable.

In addition to Serial Port A, the Rabbit 2000 startup-mode (SMODE0, SMODE1), status, 
and reset pins are available on the serial programming port. 

The two startup mode pins determine what happens after a reset—the Rabbit 2000 is 
either cold-booted or the program begins executing at address 0x0000. These two 
SMODE pins can be used as general inputs once the cold boot is complete.

The status pin is used by Dynamic C to determine whether a Rabbit microprocessor is 
present. The status output has three different programmable functions:

1. It can be driven low on the first op code fetch cycle.

2. It can be driven low during an interrupt acknowledge cycle.

3. It can also serve as a general-purpose CMOS output.

The /RESET_IN pin is an external input that is used to reset the Rabbit 2000 and the 
onboard peripheral circuits on the RabbitCore module. The serial programming port can be 
used to force a hard reset on the RabbitCore module by asserting the /RESET_IN signal.

Refer to the Rabbit 2000 Microprocessor User’s Manual for more information.
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4.3  Serial Programming Cable
The programming cable is used to connect the RCM2200’s programming port to a PC 
serial COM port. The programming cable converts the RS-232 voltage levels used by the 
PC serial port to the TTL voltage levels used by the Rabbit 2000.

When the PROG connector on the programming cable is connected to the RCM2200’s 
programming header, programs can be downloaded and debugged over the serial interface.

The DIAG connector of the programming cable may be used on the RCM2200’s program-
ming header with the RCM2200 operating in the Run Mode. This allows the programming 
port to be used as a regular serial port.

4.3.1  Changing Between Program Mode and Run Mode

The RCM2200 is automatically in Program Mode when the PROG connector on the 
programming cable is attached to the RCM2200, and is automatically in Run Mode when 
no programming cable is attached. When the Rabbit 2000 is reset, the operating mode is 
determined by the status of the SMODE pins. When the programming cable’s PROG 
connector is attached, the SMODE pins are pulled high, placing the Rabbit 2000 in the 
Program Mode. When the programming cable’s PROG connector is not attached, the 
SMODE pins are pulled low, causing the Rabbit 2000 to operate in the Run Mode.

Figure 8.  Switching Between Program Mode and Run Mode

A program “runs” in either mode, but can only be downloaded and debugged when the 
RCM2200 module is in the Program Mode.

Refer to the Rabbit 2000 Microprocessor User’s Manual for more information on the pro-
gramming port and the programming cable.
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5.  SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Rabbit single-board computers and other
single-board computers based on the Rabbit microprocessor.
Chapter 4 provides the libraries and function calls related to the
RCM2200.

5.1  More About Dynamic C
Dynamic C has been in use worldwide since 1989. Dynamic C is specially designed for 
programming embedded systems, and features quick compile and interactive debugging. 
A complete reference to Dynamic C is contained in the Dynamic C User’s Manual.

You have a choice of doing your software development in the flash memory or in the static 
RAM included on the RCM2200. The flash memory and SRAM options are selected with 
the Options > Project Options > Compiler menu.

The advantage of working in RAM is to save wear on the flash memory, which is limited 
to about 100,000 write cycles. The disadvantage is that the code and data might not both 
fit in RAM.

NOTE: An application can be developed in RAM, but cannot run standalone from RAM 
after the programming cable is disconnected. All standalone applications can only run 
from flash memory.

NOTE: Do not depend on the flash memory sector size or type. Due to the volatility of 
the flash memory market, the RCM2200 and Dynamic C were designed to accommo-
date flash devices with various sector sizes.

RCM2250 and RCM2260 RabbitCore modules have two 256K flash memories. By default, 
Dynamic C will use only the first flash memory for program code in these RCM2250 and 
RCM2260 RabbitCore modules. Uncomment he BIOS USE_2NDFLASH_CODE macro to 
allow the second flash memory to hold any program code that is in excess of the available 
memory in the first flash. 
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5.3  Serial Communication Drivers
Library files included with Dynamic C provide a full range of serial communications sup-
port. The RS232.LIB library provides a set of circular-buffer-based serial functions. The 
PACKET.LIB library provides packet-based serial functions where packets can be delim-
ited by the 9th bit, by transmission gaps, or with user-defined special characters. Both 
libraries provide blocking functions, which do not return until they are finished transmit-
ting or receiving, and nonblocking functions, which must be called repeatedly until they 
are finished. For more information, see the Dynamic C User’s Manual and Technical 
Note 213, Rabbit 2000 Serial Port Software.

5.4  TCP/IP Drivers
The TCP/IP drivers are located in the TCPIP directory. Complete information on these 
libraries and the TCP/IP functions is provided in the Dynamic C TCP/IP User’s Manual.
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The following options require more care in address selection and testing actions, as 
conflicts with other users, servers and systems can occur:

• LAN — Connect the RCM2200’s Ethernet port to an existing LAN, preferably one to 
which the development PC is already connected. You will need to obtain IP addressing 
information from your network administrator.

• WAN — The RCM2200 is capable of direct connection to the Internet and other Wide 
Area Networks, but exceptional care should be used with IP address settings and all 
network-related programming and development. We recommend that development and 
debugging be done on a local network before connecting a RabbitCore system to the 
Internet.

TIP: Checking and debugging the initial setup on a micro-LAN is recommended before 
connecting the system to a LAN or WAN.

The PC running Dynamic C through the serial port on the RCM2200 does not need to 
be the PC with the Ethernet card.

3. Apply Power

Plug in the AC adapter. The RCM2200 is now ready to be used.
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The following IP addresses are set aside for local networks and are not allowed on the 
Internet: 10.0.0.0 to 10.255.255.255, 172.16.0.0 to 172.31.255.255, and 192.168.0.0 to 
192.168.255.255.

The RCM2200 board uses a 10Base-T type of Ethernet connection, which is the most 
common scheme. The RJ-45 connectors are similar to U.S. style telephone connectors, 
except they are larger and have 8 contacts. 

An alternative to the direct connection using a crossover cable is a direct connection using 
a hub. The hub relays packets received on any port to all of the ports on the hub. Hubs are 
low in cost and are readily available. The RCM2200 board uses 10 Mbps Ethernet, so the 
hub or Ethernet adapter must be either a 10 Mbps unit or a 10/100 unit that adapts to either 
10 or 100 Mbps.

In a corporate setting where the Internet is brought in via a high-speed line, there are typi-
cally machines between the outside Internet and the internal network. These machines 
include a combination of proxy servers and firewalls that filter and multiplex Internet traf-
fic. In the configuration below, the RCM2200 board could be given a fixed address so any 
of the computers on the local network would be able to contact it. It may be possible to 
configure the firewall or proxy server to allow hosts on the Internet to directly contact the 
controller, but it would probably be easier to place the controller directly on the external 
network outside of the firewall. This avoids some of the configuration complications by 
sacrificing some security.

If your system administrator can give you an Ethernet cable along with its IP address, the 
netmask and the gateway address, then you may be able to run the sample programs with-
out having to setup a direct connection between your computer and the RCM2200 board. 
You will also need the IP address of the nameserver, the name or IP address of your mail 
server, and your domain name for some of the sample programs.

Hub(s)

Firewall
Proxy
Server

T1 in
Adapter

Ethernet Ethernet

Network

RCM2200
BoardTypical Corporate Network
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6.3  IP Addresses Explained
IP (Internet Protocol) addresses are expressed as 4 decimal numbers separated by periods, 
for example:

216.103.126.155

10.1.1.6

Each decimal number must be between 0 and 255. The total IP address is a 32-bit number 
consisting of the 4 bytes expressed as shown above. A local network uses a group of adja-
cent IP addresses. There are always 2N IP addresses in a local network. The netmask (also 
called subnet mask) determines how many IP addresses belong to the local network. The 
netmask is also a 32-bit address expressed in the same form as the IP address. An example 
netmask is:

255.255.255.0

This netmask has 8 zero bits in the least significant portion, and this means that 28 
addresses are a part of the local network. Applied to the IP address above 
(216.103.126.155), this netmask would indicate that the following IP addresses belong to 
the local network:

216.103.126.0

216.103.126.1

216.103.126.2

etc.

216.103.126.254

216.103.126.255

The lowest and highest address are reserved for special purposes. The lowest address 
(216.103.126.0) is used to identify the local network. The highest address 
(216.103.126.255) is used as a broadcast address. Usually one other address is used for the 
address of the gateway out of the network. This leaves 256 - 3 = 253 available IP 
addresses for the example given.
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6.5  Dynamically Assigned Internet Addresses
In many instances, there are no fixed IP addresses. This is the case when, for example, you 
are assigned an IP address dynamically by your dial-up Internet service provider (ISP) or 
when you have a device that provides your IP addresses using the Dynamic Host Configu-
ration Protocol (DHCP). The RCM2200 can use such IP addresses to send and receive 
packets on the Internet, but you must take into account that this IP address may only be 
valid for the duration of the call or for a period of time, and could be a private IP address 
that is not directly accessible to others on the Internet. These private address can be used 
to perform some Internet tasks such as sending e-mail or browsing the Web, but usually 
cannot be used to participate in conversations that originate elsewhere on the Internet. If 
you want to find out this dynamically assigned IP address, under Windows XP you can 
run the ipconfig program while you are connected and look at the interface used to con-
nect to the Internet.

Many networks use private IP addresses that are assigned using DHCP. When your com-
puter comes up, and periodically after that, it requests its networking information from a 
DHCP server. The DHCP server may try to give you the same address each time, but a 
fixed IP address is usually not guaranteed.

If you are not concerned about accessing the RCM2200 from the Internet, you can place 
the RCM2200 on the internal network using a private address assigned either statically or 
through DHCP.
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APPENDIX A.  RABBITCORE RCM2200
SPECIFICATIONS

Appendix A provides the specifications for the RCM2200, and
describes the conformal coating.
User’s Manual 49



It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the 
RCM2200 in all directions when the RCM2200 is incorporated into an assembly that 
includes other printed circuit boards. An “exclusion zone” of 0.16" (4 mm) is recom-
mended below the RCM2200 when the RCM2200 is plugged into another assembly using 
the shortest connectors for headers J4 and J5. Figure A-2 shows this “exclusion zone.”

Figure A-2.  RCM2200 “Exclusion Zone”
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Table A-1 lists the electrical, mechanical, and environmental specifications for the RCM2200.

Table A-1.  RabbitCore RCM2200 Specifications

Parameter RCM2200 RCM2210 RCM2250 RCM2260

Microprocessor Rabbit 2000® at 22.1 MHz

Ethernet Port
(10/100-compatible with 
10Base-T interface)

RJ-45, 2 LEDs Raw signals only RJ-45, 2 LEDs Raw signals only

Flash Memory One 256K Two 256K Two 256K

SRAM 128K 512K 512K

Backup Battery Connection for user-supplied backup battery
(to support RTC and SRAM)

General-Purpose I/O

26 parallel I/0 lines grouped in five 8-bit ports (shared with serial ports):
• 16 configurable I/O
•  7 fixed inputs
•  3 fixed outputs

Additional Inputs 2 startup mode, reset

Additional Outputs Status, reset

Memory, I/O Interface 4 address lines, 8 data lines, I/O read/write

Serial Ports
Four 5 V CMOS-compatible ports.

Two ports are configurable as clocked ports, one is a dedicated RS-232 
programming port.

Serial Rate Maximum burst rate = CLK/32
Maximum sustained rate = CLK/64

Slave Interface
A slave port allows the RCM2200 to be used as an intelligent peripheral 
device slaved to a master processor, which may either be another Rabbit 2000 
or any other type of processor

Real-Time Clock Yes

Timers Five 8-bit timers cascadable in pairs, one 10-bit timer with 2 match registers 
that each have an interrupt

Watchdog/Supervisor Yes

Power  4.75 V to 5.25 V DC, 134 mA

Operating Temperature –40°C to +70°C

Humidity 5% to 95%, noncondensing

Connectors Two IDC headers 2 × 13, 2 mm pitch

Board Size 1.60" × 2.30" × 0.86"
(41 mm × 59 mm × 22 mm)
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A.6  Conformal Coating
The areas around the 32 kHz real-time clock crystal oscillator has had the Dow Corning 
silicone-based 1-2620 conformal coating applied. The conformally coated area is shown 
in Figure A-6. The conformal coating protects these high-impedance circuits from the 
effects of moisture and contaminants over time.

Figure A-6.  RCM2200 Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering 
procedures for surface-mounted components. A new conformal coating should then be 
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Technical Note TN303, 
Conformal Coatings.
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APPENDIX B.  PROTOTYPING BOARD

Appendix B describes the features and accessories of the Proto-
typing Board, and explains the use of the Prototyping Board to
demonstrate the RCM2200 and to build prototypes of your own
circuits.
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B.3  Power Supply
The RCM2200 requires a regulated 5 V ± 0.25 V DC power source to operate. Depending 
on the amount of current required by the application, different regulators can be used to 
supply this voltage.

The Prototyping Board has an onboard 7805 or equivalent linear regulator that is easy to 
use. Its major drawback is its inefficiency, which is directly proportional to the voltage 
drop across it. The voltage drop creates heat and wastes power.

A switching power supply may be used in applications where better efficiency is desir-
able. The LM2575 is an example of an easy-to-use switcher. This part greatly reduces the 
heat dissipation of the regulator. The drawback in using a switcher is the increased cost. 

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2 
as shown in Figure B-3. 

Figure B-3.  Prototyping Board Power Supply

B.4  Using the Prototyping Board
The Prototyping Board is actually both a demonstration board and a prototyping board. As 
a demonstration board, it can be used to demonstrate the functionality of the RCM2200 
right out of the box without any modifications to either board. There are no jumpers or dip 
switches to configure or misconfigure on the Prototyping Board so that the initial setup is 
very straightforward.

The Prototyping Board comes with the basic components necessary to demonstrate the 
operation of the RCM2200. Two LEDs (DS2 and DS3) are connected to PE1 and PE7, and 
two switches (S2 and S3) are connected to PB2 and PB3 to demonstrate the interface to 
the Rabbit 2000 microprocessor. Reset switch S1 is the hardware reset for the RCM2200.
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D.2  Keypad and LCD Connections

Figure D-2.  Sample Keypad Connections

Sample Program: KEYLCD.C in SAMPLES\RCM2200.

Figure D-3.  Sample LCD Connections

Sample Program: KEYLCD.C in SAMPLES\RCM2200.
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D.3  External Memory
The sample circuit can be used with an external 64K memory device. Larger SRAMs can 
be written to using this scheme by using other available Rabbit 2000 ports (parallel ports 
A to E) as address lines.

Figure D-4.  Sample External Memory Connections

Sample Program: EXTSRAM.C in SAMPLES\RCM2200.
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